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Chapter 1- About this document

1. About this document

11 Version information

This document provides information for system managers about installing and upgrading
IRIS and RDA software.

Familiarity with operating system concepts is required.

Document code Date Description

M212924EN-D June 2025 Updated for IRIS RDA 10.3.0
Updates include:

* Updated instructions for upgrading IRIS RDA and AlmaLinux

* Corrected command for creating a directory in step 2 in
Configuring SSH (page 40)

* In chapter Configuring firewall, added that by default, the IRIS
server firewall is configured so that the NTP service is allowed
from the outside network.

M212924EN-C February 2025 Updated for IRIS RDA 10.2.0
Updates include:

* Recommendations for server computer were added. See
Hardware recommendations (page 11).

» Corrections to commands in Remote IRIS menu interface
(page 40)

» Notification conventions updated according to the ANSI
7535.6 standard. See Documentation conventions (page 8).

M212924EN-B August 2024 Updated for IRIS RDA 10.1.0
Updates include:

¢ Operating system changed to AlmaLinux 9. OS installation
instructions updated.

* Upgrade instructions updated.

» Default passwords updated.

* Information on firewall configuration added.

* Appendix structmap command moved to /RIS Programming
Guide (M212927EN).

* Appendix Installing IRIS 3DView removed (no longer
supported).

M212924EN-A May 2023 First version of this document.

This document describes IRIS v. 10.0.0, which supports RVP10
Digital Receiver and Signal Processor.

The predecessor of this document is M211315EN, which describes
IRIS versions that support RVP900 and earlier versions of RVP.
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1.2 Related documents

Table1 Related documents (English)

Document code Name

DOC236879 IRIS RDA Release Notes

M212924EN IRIS and RDA Software Installation Guide

M212925EN IRIS and RDA Utilities Guide

M212926EN IRIS Radar User Guide

M212927EN IRIS Programming Guide

M212928EN IRIS Product and Display Guide

M212923EN Radar Control Processor RCP8 User Guide

M212604EN RVPIO Digital Receiver and Signal Processor User Guide

1.3 Documentation conventions

NOTICE! Notice alerts you to a situation that, if not avoided, could result in the product
to be damaged or important data to be lost.

o Highlights important information on using the product.

g Gives tips for using the product more efficiently.

1.4 Trademarks

IRIS" is a trademark of Vaisala Oyij.

AlmaLinux" is a trademark of AlmaLinux OS Foundation.
Linux® is a registered trademark of Linus Torvalds.

All other product or company names that may be mentioned in this publication are trade
names, trademarks, or registered trademarks of their respective owners.



Chapter 2 - File system hierarchy tree

2. File system hierarchy tree

etc
F—— vaisala
L— 5risrda
images
init
| listings
| menu
| overlay
L— irisrda_templates
systemd /* service files x/
profile.d /x shell script files */
rc.d
L— init.d /* rc files x/
L logrotate.d /*x logrotate conf files */
— srv
L— iris_data
— 1ingest /* IRIS tingest files */
— product /* IRIS derived product files */
—— product_raw /* IRIS RAW (packed ingest) files x/
—— tsarchive /* saved IQ data */
— tape_inv /* tape backup metadata */
—— ascope /* Data saved from ascope utility */
—— suncal /* Sun based calibration utility data x/
| — temp /* temp storage x/
L— zdrcal /* ZDR calibration utility data x/
— usr
F—— libexec
| L— vaisala

| pipes /x pipes from data_converters x/
| irisrda /* scripts for dirisrda x/
bin /* executables for -irisrda x/
': share
X11 /x app defaults resource files */
nls /*x po files */
vaisala
L irisrda
icons /x dcon files x/
sounds /* sound files */
keys /* key files x/
L— doc /* user documentation, release notes and license files x/
1ib64 /x all libraries x/
include
I vaisala/x all header files x/
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L var

F—— log

L— Srisrda /* all log files */

L spool
L— vaisala-io
input /* Default IRIS input directory */
output /* Default IRIS output directory */
raw
volume
temp /* Conversion pipes temp storage */

M212924EN-D



Chapter 3 - Preparing for installation

4. Preparing for installation

31 Hardware recommendations

Vaisala recommends using a server computer that meets the following spesifications:

Recommendation

Drive size 512 GB SDD configured with RAID 1 (mirrored)

Memory 16 G of DDR4 Memory

CPU 2 XEON E5-2609 v3 Processors with 6 Cores, 1.9 GHz
clock speed, 6.4GT/s QPI Speed, 15M of Cache

The server provided by Vaisala meets these recommendations.

3.2 Installation image options

This version of IRIS RDA software requires the AlmaLinux 9 operating system.

Vaisala provides customized ISO images for AlmaLinux and IRIS/RDA software on the

Vaisala FTP website:

https://ftp.sigmet.vaisala.com/files/releases

ISO Image

Combined AlmaLinux OS and
IRIS/RDA sw ISO image

Notes

Automatically installs both the
AlmaLinux operating system and
the IRIS/RDA software.

Available on USB drive and FTP
site.

You can also use this image to only
install the IRIS/RDA software.

Instructions

Installing OS together with IRIS/
RDA: Chapter Installing IRIS/RDA
and AlmaLinux with Kickstart

Installing only IRIS/RDA: Chapter
Installing IRIS/RDA software

IRIS/RDA software as standalone
ISO image

This image is smaller than the
combined ISO image, so it is faster
to download.

Available on the FTP site.

Chapter Installing IRIS/RDA
software

AlmalLinux operating system as
standalone ISO image

This image is smaller than the
combined ISO image, so it is faster
to download.

Available on the FTP site.

Appendix Installing AlmaLinux

n


https://ftp.sigmet.vaisala.com/files/releases
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When installing the IRIS/RDA standalone ISO, you can select either online or offline
installation. The online option enables access to RPMs from remote repositories that are
needed if the host system does not contain dependencies that come from AppStream and
BaseOS repositories. These repositories are automatically included when the combined OS
and software ISO image used. The online installation requires Internet connection.

If you select the offline installation option, the installation only uses the repositories
provided by ISO image and does not try to access remote repositories. In this case, for
example, devel packages cannot be installed, because they require a specific version of
base packages and this requires accessing remote repositories.
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4. Installing IRIS/RDA with
Kickstart

41 Creating installation media

After creating and initializing the installation media, you can run the installation process.

411 Creating USB installation media on Windows
These instructions apply to Windows 10 and Windows 11.

When creating USB installation media on Windows, use a standalone program such as
rufus (available at http://rufus.akeo.ie/). Follow the on-screen instructions.

P 1. Launch rufus by double-clicking the program icon.
2. Insert a USB drive in the USB port.

3. Select the drop-down list to the right of the Create a bootable disk using, and select
ISO Image.

Farmat Options [
|:| Check device for bad blocks [1 Pass

]
Quick format
Createa bootable disk using [ISDImage T] A

Create extended label and icon files
Advanced Options

[ List USE Hard Drives
|:|Add fixes for old BIOSes [extra partition, align, etc.)
Use Rufus MEBR with BIOS ID | 0x30 (Default)

READY

About... | |Log | stat | | Close

4. Select the Disc icon and then select the iso image.


http://rufus.akeo.ie/
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5. Select Write in DD Image mode if a warning for the hybrid ISO image is displayed.

?ﬁGHybrid image d
I_ |

The image you have selected is an T150Hybrid' image. This means it can be
written either in I50 Image (file copy) mode or DD Image (disk irmage} mode.
Rufus recommends using IS0 Image mode, so that you always have full
access to the drive after writing it.

However, if you encounter issues during boot, you can try writing this image
again in DD Image mode.

Please select the mode that you want to use to write this image:

) Write in I50 Image mode (Recommended)
@ Write in DD Image mode

6. Select Close.

41.2 Creating USB installation media on Linux
(AlmaLinux)

n NOTICE! This operation destroys data on the device you operate on.

1. Run$ 1sblk to list block devices on your system. Take note of the output.
2. Insert a USB drive in the USB port.
3. Run$ 1sblk.

Compare the output to the previous step. The additional block device from this output
is your USB drive.

4. Run$ dd 1if=path/toAlmalinux.iso of=/dev/xxx

Where /dev/xxx is the path to the USB drive. Do not use the partition number for the
USB drive.
For example: /dev/sdc.
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4.2 Running the installation with Kickstart

} 1. In the AlmaLinux window, select Install AlmaLinux 9.4, and press Enter.

NOTICE! Do not use the option Test this media & install AlmaLinux 9.4. It skips the
configuration process.

AlmaLinux 9.4

Install AlmaLinux 9.4
Test this media & install AlmaLinux 9.4

Troublezhoot ing

2. When prompted, configure the hostname and IP address.

Enter Hostname: new-radar

Conf iguring for enpBs3
Do you want to configqure this interface? [ysml y
onf igure as static (default is DHCP)? [y~snl n

Conf iguring for enpBs8
Do you want to configqure this interface? [ysml y

onf igure as static (default is DHCP)? [y~snl y
Enter IP addres=s: 18.B.2.1
Enter netmask: 255.255.255.8

Conf iguring for enpBs9
Do you want to configqure this interface? [ysml y
onf igure as static (default is DHCP)? [y~snl y
Enter IP address: 18.8.3.1
Enter netmask: 255.255.255.8
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3. In the Installation Summary window:

a. Select Keyboard and select the desired keyboard version.

b. Select Time & Date and set the time and date.

INSTALLATION SUMMARY ALMALINUX 9.4 INSTALLATION
Eus Help!
LOCALIZATION SOFTWARE SYSTEM
E Keyboard e Installation Source @ Installation Destination
M English (US) Local media Custom partitioning selected
Language Support (g Scftware Selection KDUMP
English (United States) Custom software selected Kdump is enabled
=> Network & Host Name

€ Connected: enpiso
& Security Profile

USERSETTINGS No profile selected

O

°
-
Quit
PL ked with this icon bef inuing to the next step.

4. In the Installation Summary window, select Software Selection.

5. In the Software selection window, select Server with GUI and the software you want to
install.

By default, IRIS, RCP8, RVP10, and all data converter RPMs are selected.
For more information on the options, see Running the installation script (page 25).



>
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6. In the Installation Summary page, select Begin Installation.

INSTALLATION SUMMARY ALMALINUX 9.4 INSTALLATION
BEus Help!
LOCALIZATION SOFTWARE SYSTEM
Keyboard Installation Source Installation Destination
B e O I [©) Itatation Destine
Language Support ﬁ Software Selection KDUMP
English (United States) Cust cted Kdump is enabled
) Time & Date > Network & Host Name
R smer ork timesom € Gornected: cnpted

Con
B SecurityProfile
USER SETTINGS No profile selected

(o]

[ ]
-a

&y plete items. ith this icon inuing to the next step.

The installation process begins.

7. When the installation is complete, the system will reboot automatically.

4.3 First login and password change

The IRIS RDA software installation creates three default user accounts: radarop, observer,
and admin.

After installing IRIS RDA from installation media, the default password is xxxxxx. Changing
this password on the first login is mandatory.

n NOTICE! If you do not change the xxxxxx password, you will be locked out of the
system.

1. Select the radarop login icon.
2. Enter the default password.
3. Change the password.

4. Do the same for the other default user accounts (observer and admin).
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4.4 Enablinglogin as root for using IRIS
Focus

If you are installing IRIS Analysis and IRIS Focus on the same server, you need to enable
logging in as root.

P 1. Loginas admin user.

2. Type:

$sudo passwd root

3. Follow the prompts.

[adminEwrs ~]% sudo passwd root
Changing password for user root.
Mey z

Retype new password:

passwd: all authentication tokens updated successfully.
[adminEwrs208

4. Log out, and log in as root.

4.5 Verifying that the services are running

P 1. If you have not done so already, log in as radarop.
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2. In the terminal window, list the services currently running by typing:

# ps_iris

The COMMAND column lists the running services.

Option Running services

-rvplo

rvplo

-rcp8

rcp8

You may also see that the antenna (ant_x*) and receive (rtd_x) processes have

started.

0 IRIS does not start until you have installed the IRIS license.

More information
» ps_iris command (page 79)
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4.6 Configuring IRIS license setups

SETUP, wrs200

File Help

—— Radar Interfaces IRIS
- Input | General | License |
} Ingest |1 Product |— Output |—

IRIS License Setups, wrs200 14:05:18 4 JUN 2024 EDT x

File Help

License and Site Information Help|

License #1 |§|R|5 Features

License #2 |§|R|5 Products

License #3 I

License #4

|
License #5 |
|

License #6

Site name I

Hardware name I

Site code |§???

QLW Password I?«**************

Figure1 License setup example

Before you can use IRIS/RDA software, you must request and set up a license.

1. Open the Setup utility by typing:

setup&

20
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. In the Setup utility, select License.

a. Delete the default texts in the License fields.

b. Depending on your setup, for IRIS Style, select either Radar or Analysis.

c. In Site name, type a name for the machine (typically the host name of the machine).
For example: hel-radar

d. In Site code, type a code name for the radar site.
For example: HEL

e. Inthe IRIS License Setups window, select File > Close

f. Select File > Save and File > Exit.
. In the terminal window, type: show_machine_code

The terminal prints the licensing information about this machine. For example:

Machine Code: EMNTRK

Site Name: hel-radar

Check Code: WPEFXE

0S Name: Linux

0S Release: 3.10.0-229.el7.x86_64
Host Name: localhost.localdomain
Locking To: host

. Copy all the information under Licensing Information for IRIS Versdion
<version number>

. Contact your Vaisala representative and request an IRIS license.
Provide the information you copied in the previous step.

. When you receive the license from Vaisala, return to Setup > License and type the
License 1, License 2, ... license codes in the order listed in the license.

Depending on your configuration, you may have codes such as:
* |RIS Features Code

* |RIS Product Code

* RDA Features Code

. Select File > Save and File > Exit.

21
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8. To confirm that your license is correctly setup, start IRIS by typing:

siris

Check that the IRIS Quick Look Window starts.
If the IRIS Quick Look Window does not start, see Troubleshooting instructions.

22
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5. Installing IRIS/RDA software
(standalone)

51 IRIS/RDA installation overview

Installing the IRIS/RDA software from the installation media with a script involves the
following steps. The steps are described in detail in the following chapters.

} 1. Install the AlmaLinux operating system according to Appendix /nstalling AlmaLinux.
2. Loginas root.
See Logging in as root (page 23).
3. Install the IRIS / RDA installation media, and verify that it mounts.
See Mounting the installation media and verifying the mount point (page 23).
4. Open a terminal window.
5. Run the installation script.
6. Verify that the expected services have started.
See Verifying that the services are running (page 18).
7. Configure your licenses.
See Configuring IRIS license setups (page 20).
8. Check and update your firmware as needed:

¢ Installing 10-62 firmware (page 42)
* |nstalling RVP10 (RDA) firmware (page 44)

5.2 Loggingin as root

P 1. Inthe login screen displaying your user accounts, select Not Listed? below the user
account login box.

2. Enter root as the user name and your root password.

The system displays a welcome message after the first time you log in and a blank
screen after other logins.
If prompted, select your language and input settings.

You can now continue with the IRIS/RDA software installation.

5.3 Mounting the installation media and
verifying the mount point

The IRIS/RDA installation media can be either a USB drive or a DVD disc.

23
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} 1. Install the USB drive in the USB port of the server, or install the DVD disc in the DVD
drive.

2. If you are using a DVD drive, a small black window indicates that the DVD disc has been
recognized.

Select X in the upper right corner to close the window.

3. Verify that the installation media is recognized with the mount point by typing:

df

The installation media should be listed with the mount point in /run/media/root/
irisrda_X.XX.X, where X.XX.X is the version of software you are installing.

4. If you do not see the installation media listed, try the following:

* Insert the USB drive to a different port
* Run the 1sblk command to see if the installation media shows on the list. If it
shows, mount it manually with the command:

mount -o loop dev/<usbdevice> /mnt

, Where usbdeviice is the name of the USB drive from the Usblk list.
In the case of a DVD, replace <usbdevice> with the DVD from the Tsb 1k list.

5.4 Opening a terminal window

P 1. Inthe upper left corner, left-click Activities.

24
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2. Either type terminal in the search field on top of the window, or click on the terminal
icon at the bottom of the screen.

5 Activities Jun4 14:14

re o
» AlmalLinux

| g

DB @O

A terminal window with a prompt opens.
3. Remove the user you created during the operating system installation.

For example, if you created the user service, type:

# userdel -r service

5.5 Running the installation script

The vaisala-iris-rda-install. sh script automatically performs all the processes
the make the system ready to run. For example, the script installs the requested products
with their dependencies, creates directories, and configures paths and users.

The script also sets up a local repository that is required for installing upgrade packages via
DNF.
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1. Change to the directory where the IRIS/RDA installation media is mounted.

For example, if the mounting pointis /run/media/root/irisrda, type:

# cd /run/media/root/irisrda

2. Run the installation script with desired parameters by typing:

./vaisala-iris-rda-install.sh <parameter>

, Wwhere <parameter> can be any of the following:

—-—he'lp: Prints out the applicable parameters.

—--1iris: Installs IRIS on a running system (with all dependencies, including common
package).

-—-rcp8: Installs RCP8 on a running system (with all dependencies, including
common and rda packages).

--rvp9: Installs RVP9 on running system (with all dependencies, including common
and rda packages).

--rvp10: Installs RVP10 on a running system (with all dependencies, including
common and rda packages).

o --rvp9 and —--rvp10 options cannot be used at the same machine.

—--converter "<converter_name> <converter_name>
<converter_name> ...": Installsdata-converters-
<converter_name> on running system (with all dependencies, including common
package). Accepts converter list inside quotes as argument.

The option ——help shows all converter names that can be installed with the script.
—--online: provides access to remote repositories that is set up on system.
—--offline: forces the script to use the repositories provided by the ISO image. No
access to remote repositories.

—--with-os: If you want to point the external DVD ISO for dependencies that come
from AppStream and BaseOS, provide the mount path of the AlImaLinux DVD.
Providing ——os—media may be useful if third party dependencies are not already
installed on your system and installation image does not include those
dependencies when you are running the offline installation.

3. Reboot the system to apply changes and to run enabled services:
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5.6 Firstlogin and password change

The IRIS RDA software installation creates three default user accounts: radarop, observer,
and admin.

After installing IRIS RDA from installation media, the default password is xxxxxx. Changing
this password on the first login is mandatory.

n NOTICE! If you do not change the xxxxxx password, you will be locked out of the
system.

P 1. Select the radarop login icon.
2. Enter the default password.
3. Change the password.
4. Do the same for the other default user accounts (observer and admin).

5.7 Verifying that the services are running

P 1. If you have not done so already, log in as radarop.

2. In the terminal window, list the services currently running by typing:
# ps_iris

The COMMAND column lists the running services.

Option Running services

-rvplo rvplo

-rcp8 rcp8

You may also see that the antenna (ant_x*) and receive (rtd_x) processes have
started.

0 IRIS does not start until you have installed the IRIS license.

More information
» ps_iris command (page 79)
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6. Upgrading IRIS and RDA
software

6.1 Migrating IRIS RDA from older version
than 10.x

Follow this procedure if you have IRIS/RDA version that is older than version 10 (for
example, 9.x).

P 1. Loginasroot.
2. Prepare the USB stick for backing up the configuration:

To identify the USB stick, insert the USB stick into USB port, and list devices by running
command:

lsblk

If necessary, unmount any mount point with the command: umount /
<mountpoint>.

3. Partition the USB stick:

a. Run the fd1isk command, for example:

fdisk /dev/sdx

where sdx was identified in the previous step (identifying USB stick).
b. Follow the on-screen help to delete, create, and write to save the partition.

c. Format the USB stick with the command:

mkfs.ext4 /dev/sdx1l

Wait until the command has finished running.
d. Mount the USB stick with the command:

mount /dev/sdxl /mnt
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4. Save the IRIS/RDA configuration:

a.

b.

C.

Change the directory to /usr/sigmet/config.

Save the configuration with the command:

tar -zcvpf /mnt/config.tgz .

Unmount the USB stick with the command:

sudo umount /dev/sdxl

5. Install IRIS using Kickstart from IRIS ISO image. Follow the normal IRIS installation
instruction.

When IRIS installation has completed, follow the instructions to complete the
installation.

6. Restore the IRIS configuration:

a.
b.

C.

Login as admin.
Insert the USB stick that has the backup configuration file into the USB port.

Run the df command and identify the USB stick mounting point. Change the
directory to that mount point.

Restore the configuration with the command:

sudo tar -zxvpf config.tgz -C /etc/vaisala/irisrda/

7. Modify the IRIS setup:

a.

Edit every setup_xxx fileinthe /etc/vaisala/irisrda/ directory: change
the string that refers to /fusr/iris_datato /srv/iris_data/ as root
directory.

Replace the directory for output and input device to /var/spool/vaisala-io/
as root directory. Alternatively, run iris setup, and modify according to the file
system tree (see File system hierarchy tree (page 9)).

. Make sure all files and directories in /etc/vaisala/irisrda are owned by

operator.users.

If not, make correction with the command:

sudo chown -R operator:users /etc/vaisala/irisrda/
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6.2 Upgrading IRIS from 10.0.0 with
AlmaLinux 9.0/9.2

Follow this procedure to upgrade your system if you have IRIS 10.0.0 with AlmaLinux
9.0/9.2.

1. Log in as admin user.
2. Change directory to /etc/vaisala.

3. Run the command:

un sudo tar -zcvpf path/usbstick

4. Follow the steps in Migrating IRIS RDA from older version than 10.x (page 28) to
prepare the USB stick.

5. Install IRIS using the Kickstart IRIS ISO image with operating system.

6. After installation, restore the configuration with command:

sudo tar -zxvpd path/config.tgz -C /etc/vaisala/

7. Make sure all files and directories in /etc/vaisala/irisrda are owned by
operator.users.

If not, make correction with the command:

sudo chown -R operator:users /etc/vaisala/irisrda/

6.3 Upgrading IRIS from 10.1 onwards

Follow this procedure to upgrade your system if your system has IRIS/RDA 10.1 and you want
to upgrade it into a later release.

The upgrade is handled by the DNF package manager installed by the IRIS 10.1 installation
script. In the upgrade process, the DNF replaces existing RPMs with new RPMs.

The upgrade process includes the following steps:
1. Back up your configuration files. See Preparing for the upgrade (page 31).

2. Get the latest software release ISO image and Release Notes at https://
ftp.sigmet.com/files/releases/. See Getting upgrade software (page 32).

3. Run the upgrade installation script. See Running the upgrade script (page 33).
4. Run the Setup utility. See Running Setup after upgrade (page 33).
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6.31 Preparing for the upgrade

1. Login as root.

See Logging in as root (page 23).

. Back up and save important configuration files.

As part of the upgrade, many files are erased and replaced. However, the upgrade
procedure preserves everything in S{IRIS_CONFIG}.

a. Back up and save customized configuration files.

b. Even though this file is not overwritten during the upgrade, create a backup
of /etc/vaisala/irisrda:

# cd /etc/vaisala/
# tar cfz <config_nodename_date.tgz> 1dirisrda/

c. To back up the whole installation (for example, to support rollback), back up /etc/
vaisala:

# cd /etc/
# cp -R vaisala/ sigmet_versionNumber/

. Print the current setup.

Run the Setup utility on the old system, and generate an ASCI| listing file with the
File/L1ist command.

The format of these files can change between software versions, so you may need to
re-enter some information.

A date coded listing file is generated in the S{IRIS_LISTING} directory, typically in
etc/vaisala/irisrda/listings.

. Make sure all applications are stopped by exiting any IRIS/RDA utilities that you are

running and typing the command:

$ qiris

5. Verify that all processes have stopped by typing:

ps_iris
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6. Stop any running processes as root with the kill <process ID number>
command.

The process ID number is the first column of numbers from the ps_-iris output.

6.3.2 Getting upgrade software

New features and updates are provided as software upgrades from the following sources:

* FTP download
Connect to the Vaisala Sigmet server in ftp.sigmet.vaisala.com.
 |f using a web browser, navigateto /files/releases/<latest version>
 If using an FTP client, navigate to /foutgoing/releases/latest version>

These public releases are free of charge, but do not include support services unless you
are under warranty or have purchased a support contract from Vaisala. Contact your
Vaisala representative to arrange a support contract.

* USB drive or DVD disc
Provided as part of a support contract or upon request.

6.3.21 Downloading upgrade files

The examples in this procedure use release 10.1.0 as an example. In most cases, you install
the most recent version, labelled below as <X . XX>.

1. Create a directory named /tmp/iris—<X.XX>.
2. If you are downloading RDA software, create a directory named /tmp/rda-<X.XX>.

You should make a separate directory for each version and type (IRIS/RDA) of software
that you download.

3. Login as radarop.

$cd/
$ mkdir /tmp/rda-10.1.0

4. Change to the /tmp directory by typing:

$ cd /tmp/rda-10.1.0

On Windows machines, you can type the commands in the command prompt
(remember to use the "\" backslash for DOS).

5. Start the FTP browser.
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6. Inthe directory listing of available releases, find your release.
7. Download the irisrda_1image. iso.

Download the appropriate software image according to OS version (AlmaLinux 8,
AlmaLinux 9).

6.3.3 Running the upgrade script

This instruction assumes that the operating system stays the same.

1. Log in as admin.
2. Mount the ISO image:

sudo mount -o loop <iso-image> /mnt

3. Change the directory to /mnt:

(cd /mnt)

4. Run the command:

sudo dnf upgrade -y --allowerasing --nogpgcheck --disablerepo="" \
--repofrompath vaisala-local,$(pwd)/vaisala-iris-rda \
--repofrompath vaisala-extras-local,$(pwd)/vaisala-iris—
rda-extras \
vaisala-wr-x*

6.4 Running Setup after upgrade

After upgrading, the Setup utility fills in default values for any new settings that were added.

Vaisala recommends reading the Release notes document and then checking the new
settings to make sure they are right for your system.

1. Login as radarop.

The default password is: Valsala!
(Note that the first character is capital letter 'V, and the third character is number one
1')
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2. Launch the Setup utility.

At startup for an upgrade, Setup checks the parameters to verify that they are within
reasonable bounds and lists any problems.

The listing gives the name of the variable in question and prompts the user to consider
the repair command. Errors are usually related to new features that have not been
addressed or outdated features that do not conform to the current upgrade.

3. In the list dialog, select Repair to replace any mismatches with the appropriate default.

4. If you receive errors related to customized fields that are important to your operation,
see Invoking Setup and built-in error checking (page 34).

6.41 Invoking Setup and built-in error checking
When IRIS starts, it performs configuration and bounds checks.

For new users, the Setup parameters are typically correctly set and do not cause any
configuration errors. If an error does occur, follow these steps.

P 1. Inthe terminal window, type: setup&
The Setup utility launches.

File Help |

Radar Interfaces IRIS
- Input |1 General | License
Ingest | Product |— Output |—

There are 2 variants of the Setup utility: one for IRIS and one for the RDA (RVP
signal processor or an RCP8 antenna controller).
The RDA variant does not show the IRIS setup features.

2. Select the part of the system setup you want to check or configure.
3. Make your changes and close the window for the selected part of the system.
4. Select File > Save.

The configuration files are now updated.
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5. To create a listing file of the Setup configuration:
a. Select File > List.

A listing file called YYYYMMDDHHMM . setup is created in the S{IRIS_LISTINGS}
directory.

6. To take the configuration changes into effect, restart the application:

a. For changes made to the Setup > IRIS section, restart the IRIS daemons by typing:

qiris
siris

b. For changes to the Setup > RVP section, stop any running utilities with the
command systemctl stop <service unit>,for example:

systemctl stop iris rvpl@ rcp8

C. Restart the utilities with the command systemctl start <service unit>,
for example:

systemctl start +diris rvpl@ rcp8

RVP has a configuration state accessible through dspx. Part of that state is local to
the processor and part of it is also visible in Setup > RVP.

d. For changes to the Setup > RCP section, in addition to the above, you must stop
RCPS8 (if you have one), and stop the antenna daemons, by typing:

qiris

sudo systemctl stop rvpl0
sudo systemctl stop rcp8
qant

sudo systemctl start rcp8
sudo systemctl start rvpl0
siris

©v n n v n v n

RCP8 has a configuration state accessible through Antx. These changes take effect
when you return to the top level prompt. You must save your changes.

e License changes can affect RVP and IRIS.
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7. If an error list is displayed,

a. Check the error list for parameters that you have customized and correct these
customizations.

b. Select Repair to make corrections that are necessary for the software but do not
need to be customized for your operation.

c. Select File > Save.

6.5 Checking the kernel module status

After installation or upgrade, check that the RDA kernel module has been installed and
loaded. If the kernel module has not been loaded, the rvpl10 process will not start.

To check this, type:

lsmod | grep rda

If no data is displayed, the kernel module has not been loaded or installed properly.

To check the status of the kernel module, type:

systemctl status systemd-modules-load.service

If the kernel module is not running, start the module by typing:

systemctl start systemd-modules-load.service
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71 Configuring RDA software

After the receiving your unit from the factory, or after software re-installation, you must
configure the software to customize your system for your environment and application.

Table 2 RDA configuration tools

Configuration tool RDA device Description

setup/RVP utility RVP10 Configures the local environment required to

setup_dsp.conf run RVP support utilities such as Ascope and

- dspx.

See IRIS and RDA Utilities Guide P )

(M212925EN). Examples: radar equation parameters that are
required for calibration, pulse width definitions,
and PRF request limits.

setup/RCP utility RCP8 Configures the local environment required to

setup_ant.conf run the RCP8 support utilities that such as

- ] Antenna or Bitex.

See RVPIO User Guide )

(M212604EN). Examples: max allowed AZ/EL velocity request,
MIN and MAX elevation angles that can be
requested, and LAT/LON of radar for sun
tracking.

RVP10 NV setups RVP10 Defines the details of the sampling and

rvpl0.conf processing algorithms, as well as the

) operational configuration of the system.

See RVPIO User Guide ) ) )

(M212604EN). Examples: IF filter design and selection, PRF
limits, relative trigger timing, dual-polarization
features.

RCP8 NV setups RCP8 Configures which status and control bits are

rcp8.conf available and define the antenna servo control

. parameters.

See RCP8 User Guide . .

(M212923EN). Examples: physical or virtual tachometer
selection, shutdown safety criteria and internal
antenna simulator on/off.

profile.conf RVP10 Configures the network interface from

See RVPIO User Guide RVP10SRYV server to IFDRI10.

(M212604EN)

softplane.conf RVP10 Defines the I/0 signals on the 1/0-62 connector

See RVPIO User Guide RCP8 panel, pin-by-pin.

(M212604EN) Examples: whether a line is an input or output,

electrical specification such as RS422 or TTL,
what local variable name is associated with
each line.
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9 During installation, you must configure the Setup utility and the TTY setups for your
system.

The configuration results are stored as ASCII text . conf files, typically in the /etc/
vaisala/irisrda directory. Each file has a factory default configuration file that is stored
in the template directory. The default is:

/etc/vaisala/irisrda/templates/init/

For a radar network with identical hardware, you can perform configuration maintenance
by copying pre-tested files over the network.

7.2 Configuring firewall

By default, the firewall is configured to be active in the AlmaLinux installation. However,
some modifications are needed to enable communications between units.

By default, the IRIS server firewall is configured so that the NTP service is allowed from the
outside network.

NTP service is added to firewall configuration by RVP10 post-install script.

Additionally, WRM200 factory configuration disables firewall on IFDR10 and radar cabinet
network interfaces. WRS300 and WRS400 factory configuration disables the firewall on
radar cabinet network (IFDR is in the same network).

7.21 Configuring the firewall

IRIS Focus connects to IRIS Analysis using port 30735. By default, the firewall of the IRIS
Analysis server blocks this port. When IRIS Analysis and IRIS Focus are installed on separate
servers, you need to configure IRIS Analysis server to allow the connection to this port:

P 1. Login to the IRIS Analysis server as admin.

2. Run the following commands:

sudo firewall-cmd --add-port=30735/tcp --permanent
sudo firewall-cmd -reload

7.2.2 Configuring the IFDR10 interface

On the interface to IFDRI1O, the firewall should be disabled. To do this, move the interface to
the trusted zone. IFDR10 also needs the ntp service. It can be added to the allowed services.
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1. Use the following commands:

sudo firewall-cmd --zone=trusted --change-interface="rvpl0_interface" --
permanent

sudo firewall-cmd --add-service=ntp --permanent

sudo firewall-cmd --reload

In the command, replace rvpl0_interface with the real interface name.

You can find the interface name by looking for the network interfaces in radar server. In
the following example, we know that RVP10 is connected to 10.0.3.x network, and from
the listing below we see that the name for that interface is ens6f1.

$ ip address
1: lo: <LOOPBACK,UP,LOWER_UP> mtu 65536 qdisc noqueue state UNKNOWN group
default qlen 1000

link/loopback 00:00:00:00:00:00 brd 00:00:00:00:00:00

inet 127.0.0.1/8 scope host lo
4: ens6f0: <NO-CARRIER,BROADCAST,MULTICAST,UP> mtu 1500 qdisc mq state
DOWN group default glen 1000

link/ether 04:42:1a:1d:7d:3a brd ff:ff:ff:ff:ff:ff

altname enp59s0f0O
5: ens6fl: <BROADCAST,MULTICAST,UP,LOWER_UP> mtu 1500 qdisc mq state UP
group default qlen 1000

link/ether 04:42:1a:1d:7d:3c brd ff:ff:ff:ff:ff:ff

altname enp59s0fl

inet 10.0.3.1/24 brd 10.0.3.255 scope global noprefixroute ens6fl

valid_1ft forever preferred_1l1ft forever

7.2.3 Radar cabinet interface

Typically, the radar cabinet network interface can be moved to the trusted zone. Use the
following command and replace radar_cabinet_interface with the real interface
name. To find the interface name, look for the network name of the radar cabinet network
(typically, 10.01.x and 10.0.2.x networks).

sudo firewall-cmd --zone=trusted --change-interface="radar_cabinet_interface"
—-—-permanent
sudo firewall-cmd --reload
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7.2.4 Remote IRIS menu interface

To be able to connect to the radar server IRIS from the remote IRIS menu, the firewall must
be configured to allow all traffic from selected IP addresses. In the following command,
replace <IP_ADDRESS> with the real IP address of the IRIS machine connecting to radar.

sudo firewall-cmd --zone=trusted --add-source=<IP_ADDRESS> --permanent
sudo firewall-cmd --reload

VVNC connections to radar server

If you want to use a VNC connection to the radar server, you need to allow the vhc-server
and selected ports through the firewall. You can check the services using the following
command:

$ sudo firewall-cmd --list-services
cockpit dhcpv6-client ntp ssh vnc-server

Add allowed services using the following commands:

$ sudo firewall-cmd --add-service vnc-server --permanent
$ sudo firewall-cmd --reload

Additionally, you must open the ports used by VNC. As an example, if TigerVNC server is
started in port 5, you need to open port 5905. The default port for TigerVNC is 5900, and
when an additional port N is configured, the firewall port 5900+N must be opened. In the
example, a range of ports is opened, too.

$ sudo firewall-cmd --add-port=5905/tcp --permanent
$ sudo firewall-cmd --add-port=5910-5920/tcp --permanent
$ sudo firewall-cmd --reload

Allowed ports can be checked by the following command:

$ sudo firewall-cmd --list-ports

7.3 Configuring SSH

You must set up an ssh connection from one computer ( the host) to another (target) so
that users can login from host to target without a password, and IRIS can send data from
the host to the target.
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1. Log in to the host computer as admin.
2. Check if . ssh directory exists.

If not, then create the directory by typing:

sudo ssh-keygen -t rsa

When prompted with questions, press Enter without typing anything.
3. Type:

sudo ssh-copy-id -i id_rsa.pub radarop@remotehost

4. When prompted for login, enter the radarop password.
5. After a successful login, log out again.

6. On the host computer, test the SSH connection as admin with the command:

sudo ssh radarop@remotehost date

You should get the date and time display from the remote host without a password
prompt.

You can now send data from the host computer to the target through the IRIS product
output menu.
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8. Installing 10-62 firmware

If you have installed or upgraded the RDA software, and your system includes an 10-62 card
and connector panel, you must update the firmware running on RCP8 to be compatible with
the installed RDA software.

1. Login as admin.

2. Check for running processes by typing:

sudo ps-iris

3. Stop any running processes by typing:

sudo qiris
sudo quant

4. Loginas radarop (default password Valsala!).
You enter X-Windows.
5. Right-click and start a terminal window.

6. For each Vaisala component, type the appropriate command. For example:

Vaisala component Command

Standard I/0-62 card i062-0

Standard connector panel | i062cp-0

7. Shut down the system by typing:

poweroff

8. When Power down is displayed, turn power off with power switch on lower right of
front panel.

The FPGA software installation is complete.
9. Reboot the unit.

Follow the progress of the reboot on the monitor. The front panel LED display shows
the time of the reboot and display diagnostic messages.
The reboot takes about 1 minute.
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. Stop the RCP process by typing:

$ killall rcp8

Run the following diagnostics and observe the results:

$ rdadiags 1062-0
$ rdadiags i062cp-0

Restart the RCP8 process by typing:

rcp8 &

Verify that the restart messages show no faults.
Configure RCP.
See RCP8 User Guide (M212923EN).

Chapter 8 - Installing 10-62 firmware
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9. Installing RVP10 (RDA)
firmware

Before installing RVP10 (RDA) firmware, make sure that:

* The second Ethernet port has been configured. See Configuring the system and
network (page 65).
* |[FDRI10 is physically connected to the port.

If you have installed or upgraded the RDA software, you must update the firmware running
on IFDR10 to be compatible with the installed RDA software.

P 1. Reboot the computer.
2. Login as radarop.

The default password is: Valsala!
(Note that the first character is capital letter 'V, and the third character is number one
1)

3. If IRIS / RDA services are running, turn them off.

a. Check what is running.

# ps_iris

b. If any services are running, stop them.

# systemctl stop 1iris
# systemctl stop rvplo
# systemctl stop rcp8
# systemctl stop dspexport
# systemctl stop antennad

4. Verify that all services have stopped:
# ps_iris

If there are services running, stop them using the systemctl commands or manually
kill them.
You must be logged in as root to use the ki1l command:

# su
# kill <process ID number>
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5. If not powered, power on IFDR10, and wait for it to boot.

6. If the network cable is not attached, attach IFDR10 to the second Ethernet connection
configured for the 10.0.3.x network.

7. Verify that IFDR10 is accessible over Ethernet.
Run ping letting at least 4 packets transmit, and press Ctrl+C to exit program.
Verify that there is 0% packet loss.

# ping 10.0.3.254

10.0.3.254 is the default IP address of IFDR10.

8. Change to the repository where the image is installed (be default /usr/bin):

cd /usr/bin
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9. Use the rdaflash utility to update the IFDRI10 firmware:

rdaflash -ifdri1e

This takes several minutes. Do not interrupt programming.

NOTICE! When programming starts, do not power cycle or reboot IFDR10 until
rdaflash is successfully completed.

File Edit View Search Terminal Help

radarop@radar rvple= rdaflash -ifdrle

Open connection
d firmware

INITIALIZING Completed

done.
done

MITIALIZING Compl

OADING

NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING
NSTALLING

Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
Comple
CompLe

Activate new firmware
radarop@radar rvple>

% Error='

s Error="

Error="'
Erro

Error="'
Error="'
Error="'
Error="'
Erro

Error="'
Error="'
Error="'
Error="'
Erro

Error="'
Error="'
Error="'
Error="'
Erro

When the programming is complete, IFDR10 reboots.

10. Reboot the computer and login as radarop.

11. Verify that the expected process are running with the command:

# ps_iris
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12. Configure RVP.
See RVPIO User Guide (M212604EN).

13. If the upgrade is interrupted or not completed successfully, the unit stays in diagnostic
mode on the next reboot so you can recover from the failure.

14. For RVP upgrades, if the RDA software boots, but is unresponsive, you can force the
RVP into diagnostic mode by sticking a paper clip in the inner most hole on the side of
the enclosure.

After entering the diagnostic boot mode, you can re-flash the IFDR10 software from the
signal processor to recover from a corrupted image.

If the IFDR10 firmware upgrade is part of a software upgrade process, see Running Setup
after upgrade (page 33).
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10. Login, logout, and shutdown

10.1 Powering up

When you power-up the computer, the system goes through an automatic startup of the
operating system at the end of which the software starts and performs power-up self tests.

If you are not doing any diagnostic or software maintenance work on the system, there is no
need to log-in after power-up. When you turn the unit on, your application software takes
over.

10.2 Local and remote login

You can login either locally or remotely.

* Login locally using the local workstation or through a KVM.
* You can login remotely if ssh is enabled. Check with your network administrator.

Here, we assume a local login is used.

10.3 Default usernames and passwords

The standard software installation defines the following standard users:

* radarop
e observer
* admin

For servers installed at Vaisala, the default password is: Valsala!
(Note that the first character is capital letter 'V’, and the third character is number one '1'.)
For security reasons, changing the password is strongly recommended.

To run commands that require root privileges, log in as admin, and type sudo at the
beginning of the command.

The system administrator can change passwords using the standard Linux password
support.

10.4 Running commands with root privileges

IRIS RDA software does not include a root account. To run commands that require root
privileges:

P 1. Loginasadmin.
For servers installed at Vaisala, the default password is: Valsala!

2. Type sudo at the beginning of the command.
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10.5 Local login as operator after powerup

P 1. Atthe power-up login prompt, type rada rop and press Enter.

When prompted, provide the password (default password is Valsala!l).
An X-Window screen appears.

2. Right-click and select New Window to get a terminal window.

The top of the terminal window shows your user name, the node name of the system,
and the current directory path.

10.6 Powering off

P 1. Type poweroff.

The system goes through a shutdown sequence. When it is done, Power down is
displayed.
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11. Troubleshooting

11.1 Correcting file ownership and protection

Sometimes, when starting a program or trying to access calibration files, users cannot
access some files or they receive an error message saying they do not have privileges to do
an operation.

This is because the file ownership and protection settings are incorrect.

Do not change the file protection manually. Always use the sigmet_env -setown
command to fix the protection of your files

P 1. To correct the file ownership and protection, type:

# sigmet_env -setown

The script goes through the /etc/vaisala directory tree, changing the ownership of
the files to operator and setting the protection as follows:

* Directories—rwxrwxr-x

« All files, except executable files—rwrw-r--

* Executable files—rwsrwsr-x

11.2 Authorizing remote X—-Windows on your
node

P 1. Toenable IRIS systems running on other nodes to send output to your screen, enter the
command:

$ xhost +<host>

Where <host> is the remote hostname, or IP address.
2. Check that this works as you intend.
3. Add the appropriate command at the end of one of the following files:

* To authorize the windows as soon an anyone logs in: /etc/profile.d/
sigmet. sh

* To support just one user authorizing the windows: home
directory . bash_profile
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11.3 Making Quick Look Windows (QLW)
appear

For any problem that prevents the window from starting, IRIS prints:
OUTPUT, Error 1in open_display call.

The Radar Status menu also indicates Error and Exit next to the window process.
If you cannot identify the problem from the error message:
1. Check that the workstation is turned on and the network is up and running.
2. Login as radarop.
3. Open the Radar Status menu and toggle the Product Output process off/on.
4

. In the command prompt of the workstation where the window should appear, check
the user rights by typing:

xhost+

5. Restart IRIS on your workstation by typing:

sudo systemctl restart dris

n NOTICE! This command restarts all IRIS processes.

IRIS tests each process and restarts any that have stopped.

6. If the IRIS Quick Look Window (QLW) does not appear after typing siris in a terminal
window:

a. Loginas root.
b. In the first line of the /etc/hosts file, add the host name to the first line of the file:

127.0.0.1 <host-name> local host...
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7. If the steps above do not help, make sure the Display name is correct:

a. In the terminal window, check the value of DISPLAY with the command:

echo SDISPLAY

Typical values for local DISPLAY are :0 and : 1.
b. Open the Setup utility.

c. In the Output Device Setups section, type the DISPLAY value into the Display
name field.

Check if the QLW now appears.

11.4 Replacing failed OS RAID disks

RAID1is automatically configured on the server. However, in some cases, you may need to
remove, recover, and add new devices to RAID.

In most cases, this requires removing the failing disk and installing a new one.

e While you can do this while powered up, if the system allows you to power down, do so.

P 1. Tocheck the status of the RAID1 disk, type:

cat /proc/mdstat

When RAID1is working correctly, the terminal prints, for example:

Personalities : [raidl]
mdl126 : active raidl sda[l] sdb[0]

125032448 blocks super external:/md127/0 [2/2] [UU]
md127 : 1dinactive sdb[1](S) sda[0](S)

4520 blocks super external:imsm

¢ [UU] indicates that both disks are operational.
* [f there is a problem with one of the disks, the [UU] stringis [_U] or [U_].

2. Check if disk sda or sdb has failed.
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3. To remove the disk from RAID configuration, type:

Take care when removing the failing disk.
Remove only the disk identified as failing. In the following example, it is sdb.

mdadm --manage /dev/md/imsm@ --remove /dev/sdb

The terminal prints:

mdadm: hot removed /dev/sdb from /dev/md/imsmO®

4. Power down computer, replace the failing disk, and reboot

5. To create the partition on the replacement disk, type:

sfdisk -d /dev/sda | sfdisk /dev/sdb

6. To verify the partition, type:

fdisk -1

7. To add a new disk to the raid array, type:

mdadm --manage /dev/md/imsm@ --add /dev/sdb
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8. To check the recovery process, type:

cat /proc/mdstat

The terminal prints:

[root@wes-install ~]# cat /proc/mdstat
Personalities : [raidl]
mdl126 : active raidl sdb[2] sda[1l]
125032448 blocks super external:/md127/0 [2/2] [UU]
md127 : +dinactive sdb[1](S) sda[0](S)
4520 blocks super external:imsm

unused devices: <none>
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Appendix A. Installing
Almalinux

A1 Overview to installing AlmaLinux

o IRIS RDA 10.2.0 requires the AlmaLinux 9 operating system.

Vaisala provides a customized ISO image for AlmaLinux on the Vaisala FTP website at:
https://ftp.sigmet.vaisala.com/files/releases/AlmaLinux/

Vaisala supports two installation methods from the Vaisala spin version of the ISO image:

* Automatic - unattended installation
* Manual - interactive installation

For both installation methods you can use the local USB device as your installation media.

We recommend that you use the automatic process unless you have special system
configuration needs or if your custom configuration fails the automatic installation process.

Installing Linux requires a Linux software installation tree and a boot device. You must
transfer the AlmaLinux distributions ISO images to the media that you are going to use in
the installation.

You need the following to create installation media:

« PC running Windows 10/11, or AlmaLinux
» USB port and USB Flash Drive 64 GB
Vaisala recommends a USB 3.0 drive because data transfer is much faster than USB 2.0.

A.2 Creating installation media

After creating and initializing the installation media, you can run the installation process.

A.21 Creating USB installation media on Windows
These instructions apply to Windows 10 and Windows 11.

When creating USB installation media on Windows, use a standalone program such as
rufus (available at http://rufus.akeo.ie/). Follow the on-screen instructions.

P 1. Launch rufus by double-clicking the program icon.
2. Insert a USB drive in the USB port.
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3. Select the drop-down list to the right of the Create a bootable disk using, and select
ISO Image.

Format Options ]

[ Check device for bad blocks [1 Pass v]
Quick format "."
Createa baootable disk using [ISDImage v] [ M
Create extended label and icon files

Advanced Options

[ List USB Hard Drives
|:|Add fixes for old BIOSes (extra partition, align, etc)
Use Rufus MBR with BIOS ID | 0x80 [Default)

| READY

| About.. | [Log] | stat || Close |

4. Select the Disc icon and then select the iso image.

5. Select Write in DD Image mode if a warning for the hybrid ISO image is displayed.

e

de

?ﬁGHybrid image di
i :

o

The image you have selected is an TSOHybrid' image. This means it can be
@ written either in I50 Image (file copy] mode or DD Image (disk irmage} mode.

Rufus recommends using IS0 Image mode, so that you always have full

access to the drive after writing it.

However, if you encounter issues during boot, you can try writing this image

again in DD Image mode.

I Please select the mode that you want to use to write this image:

) Write in 150 Image mode (Recommended)

i@ Write in DD Image mode

6. Select Close.
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A.2.2 Creating USB installation media on Linux
(AlmaLinux)

n NOTICE! This operation destroys data on the device you operate on.

P 1. Run$ lsblk to list block devices on your system. Take note of the output.
2. Insert a USB drive in the USB port.
3. Run$ 1sblk.

Compare the output to the previous step. The additional block device from this output
is your USB drive.

4, Run$ dd 1if=path/toAlmalinux.iso of=/dev/xxx

Where /dev/xxx is the path to the USB drive. Do not use the partition number for the
USB drive.
For example: /dev/sdc.

A.3 Installing AlmaLinux automatically

The automated installation uses KICKSTART to run an unattended installation.

The instructions in this section are for the Vaisala-provided server. If you are using a different
system, consult your systems manual for instructions.

P 1. Power up the system by pressing the power button on the server.

2. Insert the USB drive into the USB port. If you are using the USB port for the first time,
this also enables the port.
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3. Inthe AlmaLinux 9.2 window, select Install AlImaLinux 9.2, and press Enter.

AlmaLinux 9.4

Install AlmaLinux 9.4
Test this media & install Almalinux 9.4

Troublezhoot ing

4. The installation starts. When prompted, configure the hostname and IP address.

* For one port, configure the internal network: Select Configure as static (default is
DHCP)?: Y, and enter the IP address 10.0.2.1.

» Configure a second port as DHCP by selecting Configure as static (default is
DHCP)?: N.

Enter Hostname: testme

Conf iguring for enpBs3
Do you want to configure this interface? [ysml y
Conf igure as static (default is DHCP)? [ysml y

Enter IP address: 180.8.1.28
Enter netmask: 255.255.255.8_

Then the installation will continue.
a. In the Installation Summary window, select Installation Destination.
b. Create new partitions: /, /boot, swap, /srv, and boot/ef1.

See chapters Partitioning the destination disk (page 69) and Recommended
partitioning settings (page 69).

c. In the Installation Summary window, select Begin Installation.
5. When the installation is complete, the system will reboot automatically.
6. Vaisala strongly recommends changing any default passwords.

7. Select Application > System Tools > Settings GUI.
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8. In Region & Language, configure your language settings.
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9. Depending on your configuration, you may need to configure the ports.

 If you are using Dell PowerEdge R440 server, use ports emland em2.
* If you have an American Megatrend server, your enp9s0 port is automatically
set to communicate with the IFDR10 on a 10.0.1.x network.

n NOTICE! Do not reconfigure the network port to IFDRI10.

* If you have a SuperM-icro server, your network settings for IFDR10 are not pre-
initialized. The IFDR10 10.0.1.x network is usually configured on the enp9s0,
enplsOfl, or ethl ports but is not limited to these ports.
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This example uses the enpls0f1 port.

a. Select System Tools > Settings > Network.

Settings - | X

< Network Airplane Mode OFF

5. Ethernet (enpls0fl) @ Ethernet ‘enplSOFl,
Cable unplugged

2 Ethernet (enp1s0f0)
Hardware Address 00:25:90:93:92:4D
Unknown Last used today

of Network proxy

£ — Add Profile... tod

b. Inthe Network window, select the gear icon in the lower right corner.
c. Select the Identity tab.
In MTU, type 8192.

Cancel Wired Apply

Details Identity IPv4 IPv6 Security

MName @

MAC Address -
Cloned Address
MTU | 8192 — + | bytes

d. Select the Details tab.
Select Connect automatically and Make available to other users.
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Cancel Wired

Details Identity IPv4 IPv6 Security

Link speed 1000 Mb/s
IPv4 Address 10.0.1.20
IPvi Address fe80::badl:e613:96f4:6226
Hardware Address 4C:D9:8F:BF:0A:D5
DNS

(¥ Connect automatically
[+ Make available to other users

O Restrict background data usage

Appropriate for connections that have data charges or limits.

Remove Connection Profile

e. Inthe right pane, select IPv4.
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Details Identity IPv4 IPv6

IPv4 Method () Automatic (DHCP)
(®) Manual
Addresses
Address Metmask

10.0.1.20 255.255.255.0
DNS
Separate |P addresses with commas
Routes

Address Metmask

Change Addressing to Manual.

() Link-Local Only

() Disable

Gateway

o

o

Automatic

Automatic

1
El

Gateway

| O

In the Address, Netmask, and Gateway fields, type enter the test shown in the

figure.
Select Apply.

More information
» Recommended partitioning settings (page 69)

A.4 Installing AlmaLinux manually

(interactive)

A.41 Booting the system for manual installation

You must configure the system to boot from the media device that you have created.

The instructions in this section are for the Vaisala-provided server. If you are using a different

system, consult your systems manual for instructions.
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© Ny O !

10.
1.

12.

64

. Power up the system by pressing the power button on the server.

. Insert the USB drive into the USB port. If you are using the USB port for the first time,

this also enables the port.

In the AlmaLinux 9.2 window, select Install AlImaLinux 8.7, and press Enter.

AlmaLlinux 9.4

Install AlmaLinux 9.4
Test this media & install AlmaLlinux 9.4

Troubleshoot ing

Select a language.

(This instruction assumes that English (United States) is selected.)
Select Continue.

Select the keyboard icon to select the keyboard type (default is English).
Select Language Support to select the language.

Select Time & Date to set up the time and date.

* Region: Etc
» City: Coordinated Universal Time

. Select USER CREATION.

The User creation window opens.

a. In the user name text box, enter user account name or if you wish to have the user
account name generated from the full name, enter the user’s full name in the Full
hame text box.

b. In the password text box, enter the user account's password.
c. Inthe confirm text box, re-enter the user account’s password.
d. Select Done.
If your password is weak, you are prompted to select Done a second time.
For Installation Source, select the default value (Local media).

Select Software Selection (Server with GUI), and for additional software, select
Development Tools.

Click on Installation Destination
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13. Select local Standard Disks, and check the Custom button.
14. Select Done.
15. Select LVM for the partition scheme from the drop-down menu.

Select the + icon to add a partition. For more information about the partitioning, see
Partitioning the destination disk (page 69).

A.4.2 Configuring the system and network

P 1. Inthe Installation summary window, select Network & Host Name.
2. Enter the host name in the Host name text box in the lower left corner.

a. Select the network device you wish to configure listed in the panel on the left hand
side. The selected device is highlighted.

b. In some interfaces, to enable the network interface, select the blank button next to
OFF in the upper right-hand corner.

If the button exists, slide the button to the ON position.
c. Select Configure at the bottom right-hand corner to display the Editing window.
3. Select the General tab to set the connectivity options.
Editing enpOs3
Connection name:
General Ethernet 802.1X Security DCB IPv4 Settings IPv6 Settings

Automatically connect to this network when it is available

' All users may connect to this network

Automatically connect to VPN when using this connection

Firewall zone: | Default v

Cancel Save

a. Select Automatically connect to this network when it is available.

b. Select All users may connect to this network.
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4. Select the IPv4 Settings tab.

Editing enpOs3
Connection name: | |
General Ethernet 802.1X Security DCB IPv4 Settings IPv6 Settings
Method: | Manual - |
Addresses
Address Netmask Gateway | Add

Search domains: |

|
|
DNS servers: [ | l
|
|

DHCP client ID: |

|| Require IPv4 addressing for this connection to complete

| Routes... |
L | Cancel || Save | |
| I T
a. In the Method drop-down menu, select Manual.
b. Select Add.
c. Enter the IP address, netmask, and gateway in the text entry boxes under the
headers.

d. If configuring your etho interface, type your DNS server address in the DNS server
field.

If configuring your eth1 interface, leave this blank.

e. If configuring your eth@ interface, type your domain name in the Search domains
field.

If configuring your eth1 interface, leave this blank.

f. Check the Require IPv4 addressing for this connection box near the bottom of the
page.

5. Optional: If you are configuring the computer to run RDA software and connect to
IFDRI10, you need to configure Ethernet ports. See Configuring the system and network
for RDA and IFDR10 (page 66).

6. Select Save in the lower right corner to finish network configuration.

7. Select Done in the upper left corner of the Network and Host Name tab to return to the
Installation summary window.

A.4.21 Configuring the system and network for RDA and IFDR10

If

you plan to run RDA software on this computer and connect to IFDR10, two Ethernet ports

are required.
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1. In the installation summary page, select Network and Host Name.

The required Ethernet ports should appear in the panel on the left hand side of the
Network and Host Name window.

2. Select the Ethernet tab. In the MTU field, type 8192.

Editing enpOs3
Connection name: | enp0s3
General Ethernet 802.1X Security DCB IPv4 Settings IPv6 Settings
Device: | | - |
Cloned MAC address: | |
MTU: [ 8192 -+ ]bytes
(w7 Default [ | Phy [ | Unicast || Multicast
Wake on LAN; . _ _ _ )
] lgnore [ | Broadcast || Arp || Magic
Wake on LAN password: | |
Cancel || Save
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3. Select the IPv4 Settings tab.

68

Editing enpOs3

Connection name: enp0s3

General Ethernet 802.1X Security DCB IPv4 Settings IPv6 Settings
Methed: | Manual v
Addresses

Address MNetmask Gateway Add

10.0.1.20 24 0.0.0.0

Delete

DINS servers: | |

Search domains:
DHCP client ID:
Require IPv4 addressing for this connection to complete

Routes...

Cancel Save

a. In the Method drop-down menu, select Manual.
b. Select Add.

c. Enter the IP address, netmask, and gateway in the text entry boxes under the

headers.

* |If you are configuring the Ethernet port connected to the Internet or your
corporate network: The settings in this window are specific to your network
configuration. If you are unsure what to enter in these fields, contact your IT
support.

* |If you are configuring the Ethernet interface for direct connection to the IFDRI10,
use the following settings:

Setting Value

Address 10.0.3.1
Netmask 24
Gateway 0.0.0.0

d. Type your DNS server address in the DNS server field.
e. Type your domain name in the Search domains field.

f. Check the Require IPv4 addressing for this connection box near the bottom of the

page.

4. Select Save in the lower right corner to finish network configuration.
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5. Select Done in the upper left corner of the Network and Host Name window to return
to the installation summary page.

A.4.3 Partitioning the destination disk

A.4.31 Recommended partitioning settings
Vaisala recommends the following disk partitioning.

You need the /boot/ef1i partition if your computer uses the UEFI boot.

Table 3 Recommended disk partitioning

Partition File system type Size

/home XFS 50 GB

/boot EXT4 500 MB

/boot/efi EFI 600 MB

/var XFS 100 GB

/ XFS 50 GB

swap SWAP size of RAM + 2 GB

/srv XFS All of the remaining disk space

Use the xfs file system for partitioning.
Partition /srv is a data partition.

If there is only a little disk space, you can decrease the size of the /home and / partitions by
10-20 GB.
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A.4.3.2 Partitioning the destination disk automatically

D 1. In INSTALLATION DESTINATION, start manual partitioning:
a. Select the hard disk.
b. Select Select Storage Configuration, Custom.

c. Select Done.

INSTALLATION DESTINATION ALMALINUX 9.4 INS

Device Selection
Select the device(s) you'd like to install to. They will be left untouched until you click on the main menu's "Begin Installation" button.

Local Standard Disks

900 GiB

VMware Virtual disk
sda / 900 GiB free

Disks left unselected here will not be touched.

Specialized & Network Disks

Add a disk...
Disks left unselected here will not be touched.

Storage Configuration
Automatic O Custom

Full disk summary and boot loader. 1 disk selected; 900 GiB capacity; 900 GiB free Refresh...
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2. Select Click here to create them automatically.

MANUAL PARTITIONING ALMALINUX 9.4 INSTALLATION
-

¥ New AlmaLinux 9.4 Installation
You haven't created any mount points for your AlmaLinux 9.4 installation yet. You can

Click here to create them automatically

+ Create new mount points by clicking the "+' button

New mount points will use the following partitioning scheme
LVM -

Automatically created mount points can be encrypted by default:

Encrypt my data

When you create mount points for your AlmaLinux 9.4 installation, you'll be able to view their details
here

+|-|e

AVAILABLESPACE [l TOTAL SPACE
900 GiB 900 GiB

1storage device selected Discard All Changes

After creating the automatic partitions, you need to modify the partition manually in
the next steps.

3. Modify the /home partition.
a. Select the /home partition.
b. Under Desired Capacity, set the size of the home partition (/home) to 50 G1iB.
c. Set the File System to ext4.
d. Select Update Settings.

Al



IRIS and RDA Software Installation Guide M212924EN-D

4. Create the /var partition:
a. Select the plus (+) icon.
The ADD A NEW MOUNT POINT dialog appears.

ADD A NEW MOUNT POINT

More customization options are available
after creating the mount point below.

Mount Point: fvar e

Desired Capacity:

Cancel Add mount point

b. In Mount Point, type /var
c. Under Desired Capacity, set the size of the /var partition by typing 50 G1iB.
d. Select Add mount point.
5. Select /boot.
a. Under Desired Capacity, set the size of the /boot partition by typing 500 MiB.
b. Select Update Settings.
6. Select/.
a. Under Desired Capacity, set the size of the root partition (/) by typing 50 GiB.
b. Select Update Settings.
7. Select swap.

a. Under Desired Capacity, set the size of the swap to the size that corresponds to
RAM + 2 GB.

b. Select Update Settings.
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8. Create the /srv partition:

9.
10.

1.

a. Select the plus (#) icon.
The ADD A NEW MOUNT POINT dialog appears.

ADD A NEW MOUNT POINT

More customization options are available
after creating the mount point below.

Mount Point: /srv b

Desired Capacity:

Cancel Add mount point

b. In Mount Point, type /srv

c. Under Desired Capacity, use nearly all the available server space (indicated in the
pink box) for the /srv partition by typing, for example, 284 G1iB.

AVAILABLE SPACE

680.92 GiB

Figure 2 Example of available disk space

d. Select Add mount point.
Select Done.

In the window listing the partitions, check that the partitions are defined as described
in Recommended partitioning settings (page 69).

Select Done > Accept Changes.

A.4.3.3 Partitioning the destination disk manually

1.
2.

On the installation summary page, select Destination Installation.

To select the destination disk for the AlmaLinux installation, select the Disk icon.
Once selected, a check mark appears on the icon.

Select Storage configuration > Custom.

For recommended settings, see Recommended partitioning settings (page 69).

Follow the instructions to create new partitions, or, if needed, to re-use or delete
existing partitions.
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A.4.3.31 Deleting existing partitions

If you do not want to use the existing partitions, you must delete them to provide disk space
for your installation.

D 1. Select the arrow to the left of the drive name you want to modify to expand the
partitioning scheme.

2. Select a partition to delete.
3. Select a minus sign (-) icon to delete the partition.

4. On the pop-up window, check Delete all other filesystems.... and select Delete it.

Are you sure you want to delete all of the data on sdal?

@ Delete all other filesystems in the Unknown Linux root as well.

Cancel Delete It

A.4.3.3.2 Creating new partitions

o Vaisala recommends the LVM partition scheme.

P 1 Ifthe /home partition exists, delete it by selecting the minus (-) icon.
2. Select the plus (+) icon to add partitions.

Do this 4 times, once for each partition.

74



>

Appendix A - Installing AlmaLinux

3. For each new directory, do the following:

ADD A NEW MOUNT POINT

More customization options are available

after creating the mount point below:.

Mount Point: Isrv v

Desired Capacity:

Cancel Add mount point

a. From the Mount Point menu, select the directory.

b. Go to ADD A NEW MOUNT POINT > Desired Capacity, and type the value
recommended in Recommended partitioning settings (page 69).

c. Select Add mount point.

. Create the /srv partition:

a. In the Mount Point field, type /srv.
Type a number larger than the remaining data size. For example: 99999999999.
b. Select Add mount point.

. One at a time, select each partition, and modify the value in the Desired Capacity field

with recommended values.

For File System Type, you can select either EXT4 or xfs.

6. Select Done > Accept changes to finish partitioning.

When you have completed partitioning, do one of the following:

* If you are doing a manual installation, go to Starting the installation (page 76).
* |f you are doing an automatic installation, go back to Installing AlmaLinux automatically

(page 57).

A.4.3.3.3 Re-using existing partitions

If your disk has an operating system installed, the partitioning scheme list is displayed.

1. To expand the partitioning scheme, select the arrow to the left of the drive name you

want to re-use.

. In the partition window, for each partition shown in the left pane, select the partition,

and enter the name shown in the Mount Point field.

For the swap partition, you do not need to enter the mount point name, but you still
need to perform steps 3 and 4.

3. Check the Reformat check box next to the File System drop-down list.

4. Select Update Settings.
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5. When you have updated the settings for all the partitions, select Done.

6. Select Accept Changes to return to the installation summary page.

A.4.4 Starting the installation

Before starting the installation, make sure you have your root password and user account
information.

1. In the lower right corner of the installation summary page, select Begin installation.
The user settings configuration page appears.

2. While the installation process is in progress and before the end of the installation,
configure the root password.

3. When installation status shows complete, select Reboot and remove the installation
media.

The installation takes 20 ... 30 minutes.

4. If the server does not reboot automatically, use the power button to power cycle the
system.

5. If on the first boot you see the prompt window Accept the License Information, in the
initial setup window:

a. Select License Information.
b. Check the I accept the license agreement box.
c. Select Done.
d. Select Finish configuration.
Login screen is displayed.
6. Disable monitor negotiation.

7. The first time you login to each new account, follow the series of windows to verify your
keyboard and localization settings.

a. Select Next until you get to the thank you screen.
b. Select Start using.

8. Log out of the user account to continue with the installation.

More information
» Disabling monitor negotiation (page 76)

A.4.5 Disabling monitor negotiation

During manual operating system installations, Vaisala recommends disabling monitor
negotiation to ensure that the server recognizes the monitors.
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1. Inthe /etc/default/grub file, after the quiet in GRUB_CMDLINE_LINUX add:

nomodeset

2. Save your changes.

3. To update the configuration file, run the following script:

cd /boot/grub2/
grub2-mkconfig -o grub.cfg

A.4.6 Configuring time sync with chronyd

You can configure your machine to time sync with another machine using chronyd.

1. Inthe /etc/crony. conf file, update the lines that start with the word server by
removing the default server lines and adding your own. For example:

# configure the servers for synchronization using ip address or name
server 198.102.75.10 1iburst
server 0.centos.pool.ntp.org iburst

2. If chronyd is already running and you would like changes to take effect, use the
following command:

#systemctl restart chronyd.service

3. If you would like NTP to start automatically on restart, type:

#systemctl enable chronyd.service

This takes effect after the next reboot. To start without rebooting, type:

#systemctl start chronyd.service

The system takes 15 minutes to sync the time. If the times are more than 10 minutes
apart, NTP assumes there is an error and does not change the time.
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4,

To check on the status of chronyd, type:

# chronyd sources -v

The first character before the server host is *x when it is time synced.

A.477 Rebooting the system

1.
2.

When the installation is complete, select Reboot to reboot the system.

Depending on your system bios boot sequence setting, you may need to remove the
installation media right after you see the system shutdown complete window flash by in
order to boot using the hard drive.

A.4.8 Logging in with your user account

After rebooting, the login window shows the user account you created.

1.
2.

N O o bW
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Select your user account, and enter your password in the text box.
Select Signin.

The first time you log in to each new user account, you are asked to set some
initialization settings. The default settings are normally properly set during the
installation process, and no setting changes should be required.

In the Welcome window, select your language, and select Next.
In the Input Sources window, verify your source, and select Next.
In the On-line Accounts window, select Next.

In the Thank you window, select Start using AlmaLinux.

Read the GNOME Help window and press X in the upper right corner to close the
window.

The installation and initialization process for AlmaLinux is complete.
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Appendix B. IRIS Diagnhostic

Utilities

B.1 ps_iris command

Use the ps_1ris command to list currently active IRIS, antenna, and utility processes,
including information about their owner UID, PID, time start time, and total CPU time.

g To stop a process, use the PID as an argument to the kill command.

For example:

Detached Processes:

USER GROUP
operator users
operator users
operator users
operator users
operator users
operator users
IRIS_REINGEST
operator users
operator users
operator users
operator users
IRIS_WATCHDOG
operator users

Antenna Processes:

USER GROUP
operator users
operator users
operator users
operator users

PID PPID NI PR

3353
3355
3399
3407
3411
3413

3415
3418
3420
3423

23970

PID

1756
1789
1793
1823

1 0

N
IS

=
© ® A b

PPID

1789

15
27
15
11
11

15
15
19
19

27 0.

NI PR

0 19
-15 34
-15 34
-15 34

®© 6 6 6 6
© h© OO

®© 6 6 o
© & & o

0

%CPU
0.
0.
0.
0.

%CPU TIM

19 o. 0:

©o N o o o

© © © ©

0
0
0
0

100
:01
102
109

108 0.

TIME
0:04
0:51
1:10
1:08

© ®© © ©

© ®© © ©
© © © K

%MEM VSz
02 0.
100
:49
100
:17
100

168216
142236
136788
136768
143124
157800

© O © © © O

180620
156556
136776
138996

0 142164

%MEM
0.0 115
0.0 115
0.0 115
0.0 115

COMMAND

server IRIS_SERVER
sserver IRIS_SSERVER
ingfio IRIS_INGFIO
network IRIS_NETWORK
product IRIS_PRODUCT
reingest

output IRIS_OUTPUTOO01

output IRIS_OUTPUT002
input IRIS_INPUTO1
watchdog

ingest IRIS_INGEST

VSZ COMMAND

676 ant_logd ANT_LOGD
684 ant_rcvd ANT_RCVD
684 ant_rcvd ANT_RCVD
680 ant_xmtd ANT_XMTD
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Stand-alone Utilities:

USER GROUP PID PPID NI PRI %CPU TIME %MEM VSZ COMMAND

radarop radarop 23933 23923 0 19 0.0 0:00 0.0 116244 audio
iris_audio

operator users 4321 4319 4 15 0.0 0:00 0.0 12636 clntRecv
CLNT_RECV_WINDOW -pipe 8

radarop radarop 23923 4163 0 19 0.0 0:04 0.0 189464 1ris

radarop radarop 23934 23923 0 19 0.0 0:00 0.0 116236 iris_clnt_rcv
7 1073741826

operator users 3330 1 O 19 4.6 67:30 0.0 699324 /rcp8 -
console /dev/null

operator users 2021 1 O 19 9.4 138:57 0.4 796880 /rvpleO -
daemon

operator users 2297 2021 - 50 12.0 176:43 0.3 275560 rvplOproc
RVP10_PROC-0

operator users 2347 2021 - 50 11.8 172:44 0.3 275556 rvplOproc

RVP10_PROC-1

B.2 show_iris command

Use the show_1ris command to show information about the IRIS process: When it started,

the present state of semaphores and event flags, and the current inventory of in-use
products.

The show_1ris command also provides command line options for in-use bits. For more
information, type show_1iris -help.

$ show_1iris

IRIS Activity on 'hot' at: 09:52:52 17 SEP 1999

IRIS V7.11 was started at 16:19:38 16 SEP 1999 by 'joe'.
Manual startup from TTY:'/dev/tty' ; Restarts:1

Features License: 00004001-000101-WAHRMA-01-Y9ANHF
Products License: 000007FF-000101-WAHRMA-03-WFW4KR
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Present states of Semaphores...

PROCESS CONTROL: FREE (ID: 5833) PROCESS MODES: FREE (ID: 5826)

TASK SCHEDULE: FREE (ID: 5834) PRODUCT SCHEDULE: FREE (ID: 5831)
INGEST DIRECTORY: FREE (ID: 5831) PRODUCT DIRECTORY: FREE (ID: 5849)
DEVICE TABLE: FREE (ID: 5852) MODE SWITCH TABLE: FREE (ID: 5834)
ARCHIVE DIRECTORY: FREE (ID: 5834) ERROR LOG: FREE (ID: 5834)

Present states of Event Flags...
RTDISP: CLEAR INGEST: CLEAR

INGFIO: CLEAR INGFIO MAPPING: SET
INGFIO WAITING: SET WATCHDOG: CLEAR
PRODUCT: CLEAR REINGEST: CLEAR
NETWORK: CLEAR NORDRAD: CLEAR
GLOBAL MAPPED: SET

Event Flags SET for Output Processes: 7 8

Event Flags SET for Network Child Processes: 1 2 3 456 7 8 9 10 11 12 13 14
15 16

Checking INGEST qinventory for in-use files:

Total files checked: 92, total in use: 0.

Checking PRODUCT 1inventory for in-use files:

Total files checked: 260, total in use: 0.
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======= Product Inventory Contents =======

Prod Type Count
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B.3 sigmet_env Command

Use sigmet_env to test or troubleshoot items associated with an IRIS installation.
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To sue the command, log in as a normal IRIS user, run sigmet_env. The sigmet_env

command checks the following:

The following example shows a case with a bad file name of . TSC.
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* That all the IRIS operators and observers are in the /etc/users file.
* That all IRIS environment variables that point to directories are defined and the
directory exists, and the directory can be read and written as required.

* For obvious bad file names in the saved menu directory.

* That IRIS executable files which require the set-UID-on-execute bit set are set

with the correct UID.

* The RDA (RVP/RCP) environment.



$ sigmet_

Checking
Checking
Checking
Checking
Checking
Checking
Bad menu
Checking

env

IRIS_OPERATORS list...

IRIS_OBSERVERS list...

installation directories...

configuration directories...

data directories...

file names in IRIS_MENU...

filename: '/etc/vaisala/irisrda/menu/.TSC'
root file ownerships...

Errors Detected -- Please Check Printout

Appendix B - IRIS Diagnostic Utilities
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Appendix C. Alternative
Configurations

C.1 Defining the operator list in the startup
file

Most environments can function with radarop and observer users without any further

definitions. If you wish to manage named users, follow the instructions below.

The /etc/vaisala/irisrda/profile. conf file defines some of the base
configuration, including the lists of users who can operate IRIS fully, and who can observe its
operation but not make any changes.

Every IRIS user must share group access to files owned by the operator by being a
member of the users group.

D 1. Edit the file and change these as needed.

operators='radarop operator john george mary root'
observers="'observer'

2. Check your environment by typing:

$ env | grep IRIS
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Warranty

For standard warranty terms and conditions, see vaisala.com/warranty.

Please observe that any such warranty may not be valid in case of damage due to normal wear and tear,
exceptional operating conditions, negligent handling or installation, or unauthorized modifications. Please
see the applicable supply contract or Conditions of Sale for details of the warranty for each product.

Technical support

Contact Vaisala technical support at helpdesk@vaisala.com. Provide at least the following
supporting information as applicable:
* Product name, model, and serial number
» Software/Firmware version
* Name and location of the installation site
* Name and contact information of a technical person who can provide further
information on the problem

For more information, see vaisala.com/support.

Recycling

s E Recycle all applicable material according to local regulations.
L
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